VideoStudim;{;

Reviewer’s Guide



Corgl® . (Pro]
VideoStudio x5

Contents
1 | Introducing Corel VideoStudio Pro X5.........cccieirmernnnnes 1
2 | Customer profiles ......c.ccormeeiiimmmiiiimesii 3
3 | What's included?.........coommeiiimmeiiiimeeiirrne s 5
4 | New and enhanced features .........ccoiciimiimiincinninneinen, 7
Fast and easy HD video editing..........coccuuiiiiiiiiiniiiiee e 7
Advanced visual effects and animation.............cccccoiii 10
Complete screencast production ...........occueieiieiiiiiiiie e 12
Innovative sharing 0ptioNs ... 13
5 | Defining features.......ccoiiiiiirciin i 15
6 | Multi-threading at work........cccciiimieiiiiieniineea, 21
Video preview performance sCeNario.........c.uuevieeeiiiiiieeee e 21
Transcode performance SCENANio .........coiviiiiiiiiiiiee e 22

VideoStudio Pro cOmpariSONS...........eeeieeiiiiiiiiiaee e e e eeeeee e 22






Introducing Corel® VideoStudio® Pro X5

“The best camera is the one you have with you.”

This old photographer’s adage rings equally
true for today’s videographers. According to
InfoTrends, 2012 marks the “first year that mobile
phones have taken the leading role in video
capture.”

The implications of this trend are clear: video
capture is becoming more pervasive thanks to
the spontaneity offered by smart phones and
other mobile devices.

VideoStudio® Pro X5 is an all-in-one video editor
that combines creative editing, professional
effects, complete screen recording, interactive
web video, and total disc authoring. Ultrafast and
packed with intuitive tools, it helps you create
everything from family movies and slideshows to
stop-motion animations, screen recordings of
tutorials, presentations, and game play, and
much more. In addition, with native HTML5 web
video output, easy online and mobile device
sharing, and advanced disc authoring, you can
share your productions everywhere.

Fast and easy HD video editing

With its simple 1-2-3 workspace, Instant Project
templates, and advanced multi-core acceleration,
VideoStudio Pro X5 helps you get started
immediately and finish fast. By employing multi-
threading, VideoStudio Pro X5 fully harnesses the
processing power of multi-core technology,
which means that you can do more and wait less
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At Corel, development for VideoStudio® Pro has
always emphasized simplicity, speed, and quality.
We want to help people with video to quickly and
easily make the cuts and embellishments they
envision so they can share their video with the
world in whichever format they choose.

This release offers new avenues of creative
expression, increased application efficiencies,
and powerful new features that position
VideoStudio Pro to address new customers and
new use cases, such as online training, product
and business demonstration, and education.

— especially on today’s triple and quad-core PCs.
And when you're looking for a little creative
inspiration, you can visit our new online trading
community, photovideolife.com (English only),
where you can connect with other users, get the
latest VideoStudio Pro news, and download both
free and premium templates and additional
content, such as 3D titles and animations.

What is multi-threading?

Multi-threading is the best way to tap into the processing
power of modern multi-core processors. It lets VideoStudio

Pro X5 distribute processes across several PC cores, which
means that those processes are completed in parallel, faster
than ever before.

Advanced visual effects and animation

VideoStudio Pro X5 now offers you greater
creative freedom with more multimedia tracks, so
you can incorporate up to 20 overlay tracks which
can consist of video clips, graphics, or photos,
two title or subtitle tracks, and four audio tracks.
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In addition, new support for multi-layer graphics,
means you can drag and drop Corel® PaintShop~
Pro (PSP) graphics into your video productions.
VideoStudio Pro X5 automatically detects and
distributes each layer of the graphic onto
separate overly tracks in the Timeline, which lets
you apply effects and animations to the individual
layers.

What are multi-layer graphics?

In Corel PaintShop Pro and other graphic-design software, a
layer is like a single sheet of paper that contains an element
of the complete graphic. The non-element portion of a layer
is often transparent, so you can see through it to the layer
below. VideoStudio Pro X5 detects layers and distributes
them to separate overlay tracks, which gives you a wide
variety of new compositing and animation options.

Complete screencast production

VideoStudio Pro X5 introduces new screen
recording tools that make it easy to create
complete screencast productions — and for just a
fraction of the price of the leading brand. You can
quickly and easily capture the activity on your
screen, add voice-over narration, background
music, and all the titling, subtitles, animations,
transitions, and visual effects that VideoStudio
Pro has to offer. Its high-speed rendering, multi-
format authoring, and complete editing
functionality put VideoStudio Pro X5 a giant step
ahead of conventional screen recording software.

Whether you're a business looking to reduce the
costs associated with training, or just a regular
Joe trying to teach something technical to a loved
one separated by miles, the difference in cost
between a leading screen-recording solution and
VideoStudio Pro X5 represents massive savings.

What is a screencast?

Screencast is the popular name for a video production made
by recording activity on a computer screen. Screencasts are
instrumental in the world of training, and usually contain

an audio voice-over as narration. Screencasts are also
rapidly gaining popularity with Youtubers, businesses
demonstrating their products or services, and gaming
enthusiasts.
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Innovative sharing options

With VideoStudio Pro X5, you can quickly and
easily create interactive online video, burn
professional-quality discs complete with menus,
titles, and transitions, upload directly to
YouTube”, Vimeo®, Facebook®, and Flickr®, as well
as output your videos for specific mobile devices.
New support for HTML5 lets you produce
dynamic projects that let viewers interact with
your video. You can easily add chapter and cue
points, just as you would with a disc-based
production. And you can get started right away
by using one of the included HTML5 Instant
Project templates. Formerly the domain of
gearheads and the creative agency, this puts
interactive HTMLS5 video in the reach of anyone
using VideoStudio Pro X5.

What's more, VideoStudio Pro X5 provides an
advanced disc authoring solution, which lets you
create professional-quality DVD and Blu-ray”
discs, complete with menus, titles, subtitles, and
transitions. Plus, you can add your own custom
decorations by replacing default button and icon
images with your own graphics. You can even
burn from an ISO disc image, which is great for
disc replication.

What is HTML5?

HTMLS is the new standard for HTML, the language that
drives the web. It has been designed to allow for
interactivity and better presentation of video online, and

will eliminate the need for browsers to install add-ons such
as Adobe® Flash®, Java®, and Microsoft® Silverlight®.
HTMLS5 enables an interactive online video experience with
hyperlinked cue and chapter points, onscreen graphics, and
transitions.
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Customer profiles

With the proliferation of camera-enabled mobile
phones and devices, video shooting and editing has
become increasingly mainstream. No longer is
video editing the sole domain of the tech-savvy.
Here's a snapshot of the personas that inform our
development priorities.

Multimedia enthusiasts

The unifying trait among these traditional users of
video editing software is that they're in it for fun.
They have a wide range of creative interests and
enjoy the impact their video productions have on
their audience. They have multiple cameras, are
sophisticated and tech-savvy, and enjoy using
VideoStudio Pro for its speed, stability, rich feature
set, and creative flexibility.

Adventurous and outgoing families

Families seek out video-editing software so that
they can share the precious moments they've
captured on video. They are compelled to share as
a means to further their connections to friends and
family, whether it’s video of their latest vacation, a
family milestone, or a kid’s sporting event. Limited
for time due to their busy lifestyles, these families
prefer VideoStudio Pro for it's fast, responsive, and
easy editing environment. They simply want to get
itin, get it done, and get it out.

Web authors

The web is where video reveals the full potential of
the communication power. Afterall, why use words
when you can show something more quickly and
easily with video? With the emerging standard of
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HTML5, digital media is a central component of the
Internet’s future. Web authors want people to
interact with their videos online without hassle or
interuption, such as the need to install plug-ins.
VideoStudio Pro X5 is the world’s first video editor
with HTMLS5 output, helping web authors to create
compelling experiences with interactive links and
cues in their videos.

Online video enthusiasts

More than simply a place to share video, YouTube,
Vimeo, and similar sites are communities for
individual expression and social interaction. In
many ways, they offer a glimpse at the future of
entertainment. They provide a platform where
anyone with a talent or a creative bent can engage
with anyone in the world and develop a following.
Youtubers and online video enhusiasts are
passionate about their software choices and are
quickly frustrated with products that don’t meet
their needs. They are, however, fiercely loyal to their
tools that work.

Educators and trainers

Educators and trainers consider screencasting a
valuable learning aid and want the ability to build
interactivity into their tutorials and presentations.
They also enjoy the creative applications of video
editing techniques, such as stop-motion animation.
The broadening of HTML5 development tools, the
introduction of screen recording, and the potential
cost savings when compared to the leading brands
of screen recording software, all make VideoStudio
Pro X5 a legitimate choice for educators.
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What's included?

Main application

* Corel® VideoStudio® Pro X5: This all-in-
one video editor combines a simple 3-step
workspace with creative editing, professional
effects, complete screen recording, interactive
web video, and total disc authoring.

Supporting applications and content

e DV-to-DVD Wizard: The DV-to-DVD Wizard
lets users capture video from a DV camcorder,
add a theme template to it, and then burn it
directly to DVD.

* NewBlue®FX: A variety of NewBlueFX
animated effects, picture-in-picture effects,
and sound enhancement tools are built right
into VideoStudio Pro X5 to help you
customize your video clips.

* SmartSound®: With integrated SmartSound
audio, you can easily built a fantastic
soundtrack, with sound effects, voice-overs,
and masterful mood music.

Minimum system requirements

¢ Microsoft® Windows® 7, Windows Vista®,
Windows® XP, with latest service packs
installed (32-bit or 64-bit editions)

* Intel® Core” Duo 1.83 GHz, AMD Dual-Core
2.0 GHz (multi-core processor recommended)

* 2 GB of RAM (4 GB or higher recommended)

Corgl" . m
VideoStudio x5

128 MB VGA VRAM (1 GB or higher
recommended)

3 GB of free hard drive space
Minimum display resolution: 1024 x 768
Windows®-compatible sound card

Windows®-compatible DVD-ROM for
installation

Recordable Blu-ray” drive required for
creating Blu-ray” discs

Internet connection required for accessing
online features and video tutorials

Internet connection may be required to verify
the serial number during installation

Input/output device support

1394 FireWire® cards for use with DV/D8/HDV
camcorders

Support for OHCI Compliant IEEE-1394
USB Video Class (UVC) DV cameras

Analog capture cards for analog camcorders
(VFW and WDM support for Windows XP and
Broadcast Driver Architecture support for
Windows Vista and Windows 7)

Analog and digital TV capture devices
(Broadcast Driver Architecture support)

USB capture devices: Web cameras, and disc/
memory/hard drive camcorders
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* Windows-compatible Blu-ray, DVD-R/RW,
DVD+R/RW, DVD-RAM or CD-R/RW drive

* Apple® iPhone®, iPade, iPod classic® with
video, iPod touch®, Sony® PlayStation
Portable®, Pocket PC, smartphones

Input format support’

* Video: AVI, MPEG-1, MPEG-2, AVCHD",
MPEG-4, H.264, BDMV, DV, HDV", DivXe,
QuickTime®, RealVideo®, Windows Media®
Format, MOD (JVC® MOD File Format), M2TS,
M2T, TOD, 3GPP, 3GPP2

* Audio: Dolby® Digital Stereo, Dolby® Digital
5.1, MP3, MPA, WAV, QuickTime, Windows
Media® Audio, Ogg Vorbis

* Images: BMP, CLP, CUR, EPS, FAX, FPX, GIF,
ICO, IFF, IMG, 12K, JP2, JPC, JPG, PCD, PCT,
PCX, PIC, PNG, PSD, PSPImage, PXR, RAS,
RAW, SCT, SHG, TGA, TIF, UFO, UFP, WMF

* Disc: DVD, Video CD (VCD), Super Video CD
(SVCD)

Output format support?

* Video: AVI, MPEG-2, AVCHD, MPEG-4,
H.264, BDMV, HDV, QuickTime, RealVideo,
Windows Media Format, 3GPP, 3GPP2, Webm

* Audio: Dolby Digital Stereo, Dolby Digital
5.1, MPA, M4A, WAV, QuickTime, Windows
Media Audio, Ogg Vorbis

* Images: BMP, JPG

e Disc: DVD (DVD-Video/DVD-VR/AVCHD),
Blu-ray Disc” (BDMV)

* Media: CD-R/RW DVD-R/RW, DVD+R/RW,
DVD-R Dual Layer, DVD+R Double Layer,
BD-R/RE

1. Some input format support may require third party
software.

2. Some output format support may require third party
software.
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Other versions of VideoStudio®

The following versions meet the needs of more advanced users
as well as the education and corporate licensing markets:

VideoStudio® Pro X5 Ultimate

Corel's most comprehensive
video-editing collection
provides all the benefits of
VideoStudio Pro X5, plus the
following special effects
add-ons:

* proDAD VitaScene
V2 LE — more than 100
broadcast-quality fully
customizable professional
effects. The interactive
preview lets you quickly
add high-quality
transitions, text effects,
filters, image enhancements, and more to your videos.

* proDAD RotoPen — exclusive to VideoStudio Pro X5 Ultimate,
these animated pen effects let you draw on maps, illustrate
with light or video, or apply animated pen effects to any path.

* Boris Graffiti 5.4 — this integrated 3D titling and vector
animation plug-in lets you create broadcast-quality titles and
graphics. You can easily make sophisticated title animations,
such as type on text, text on a path, jitter, and randomization.
Plus, you can create 3D text with bump maps and reflections.

* proDAD Mercalli SE — this extreme image correction and
video stabilization plug-in gives you rock-steady video, no
matter how fast the action. This version includes revolutionary
3D video stabilization, plus rolling-shutter compensation that
will remove wobble and skew caused when panning.

* NewBlue® Motion Effects — get 100 action and energy
effects for your scenes from this collection of 10 motion filters.

* NewBlue® Titler EX — this easy-to-use titling solution lets
you create beautiful, complex, and compelling 2D and 3D title
graphics.

VideoStudio Pro X5 Ultimate is not available in all regions.
Please visit www.corel.com/videostudioultimate for more info.

Corel VideoStudio® X5

This license-only version of VideoStudio is simplified with fewer
tracks and advanced effects to provide a streamlined and easy-to-
use video-editing solution for the education and other licensing
markets. It provides a low-cost but well-featured video editor that
significantly exceeds the limited functionality of the freely
available Windows® Movie Maker or other low cost options that
are typically encountered within educational institutions.
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New and enhanced features

VideoStudio® Pro X5 is an all-in-one video editor
that combines creative editing, professional
effects, complete screen recording, interactive
web video, and total disc authoring.

Fast and easy HD video editing

VideoStudio Pro X5 provides a simple 3-step
workspace that guides you through a video project,
and offers performance efficiencies that dramatically
enhance its speed on multi-core processors.

New! Advanced multi-core acceleration:
VideoStudio Pro X5 employs multi-threading to fully
harness the processing power of today’s multi-core
PCs. By assigning different software procedures to
different cores, VideoStudio Pro X5 generates speed
gains that are significantly more pronounced than
simply enabling the additional memory addressing
capabilities of 64-bit systems. With its advanced
multi-core acceleration, VideoStudio Pro X5

distributes processes across several PC cores so that
those processes are completed in parallel. This
means that you’ll spent less time waiting while
editing your movies in a substantially faster and
more responsive environment.

For more information on multi-core acceleration,
including how VideoStudio Pro X5 stacks up against
the competition and previous versions, please visit
Chapter 6: Multi-threading at work.

New! Workspace scalability: In response to
user feedback, you can now adjust the size of the
main application window. This broadens the
workspace flexibility that was introduced with
VideoStudio Pro X4. You can continue to dock,
undock, drag, distribute, and restore windows in
any configuration that you want. The ability to
scale the main application window is especially
useful, for example, if you are working with
multiple applications open at the same time.

You can distribute the scalable VideoStudio Pro X5 workspace over multiple monitors to maximize editing space.

Corgl" . m
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New! Template organization: The Library
now includes an Instant Project tab, which makes
templates more discoverable. It's now easier than
ever before to browse, preview, and select a
template. You simply click any template icon in
the Library, click Play to view it in the Preview
Window, and then drag the icon into the Timeline
to start using it.

The Library organizes templates in five logical
categories: Beginning, Middle, Ending, Complete,
and Custom. The Custom category is reserved for
templates that you modify, and for any templates
that you download from the Corel® Guide or from
the photovideolife.com community.

A new Instant Project tab in the Library makes it easier to find templates.

New & Enhanced! Corel® Guide: There is
always something new to discover in the Corel
Guide. This unique resource is a one-stop shop for
useful information, online Help, product updates,
add-ons, freely downloadable media packs,
additional paid content, and training videos.

The Learn tab provides 24-7 access to the
application’s online Help and to proficiency-
building videos from the CorelVideo channel on
Vimeo. The Do More tab presents a collection of
downloadable templates, titles, fonts, creative
effects, and editing tools.

With VideoStudio Pro X5, customers sign on to
the Corel Guide to access all of their content. By
engaging with the Corel Guide, users will receive
notifications when new templates or other
helpful tools become available.

[ 8 ] Reviewer's Guide

The Corel Guide provides access to additional
templates and content.
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New! Free online template trading: There's
no faster or easier way to create your movie than
to start from a template. You can modify
templates in any way you see fit, follow them to
the letter, or use them to kick-start your creativity
by borrowing specific parts. Visit our free trading

community at photovideolife.com (English only),
where you can download a wide variety of both
free and premium movie templates, as well as
cool Corel® MotionStudio 3D" animations. While
there, you can ask a question, read the blog, join
a discussion, and find helpful tips and tutorials.

For registered users of VideoStudio Pro X4 and higher, photovideolife.com provides downloadable templates and
other content to use in the productions, as well as the ability to upload and share their own content and templates.
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Advanced visual effects and animation

Whether you're a budding videographer or a
seasoned veteran, VideoStudio Pro X5 makes it
easy to simply drag and drop visual FX into your
project. You can also take advantage of Corel’s
other multimedia tools for additional creative
flair, such as MotionStudio 3D for titles and
animations, or PaintShop Pro and CorelDRAW®
for multi-layer graphics.

New! Import multi-layer graphics: You can
now add multi-layered Corel® PaintShop™ Pro

O —ec—
—
f

(PSP) graphics to your movies by simply dragging
a graphic to the Timeline. For businesses, the
ability to import — for example, a print ad —
makes it easy to produce videos that share a
consistent look and feel with other collateral.

VideoStudio Pro X5 automatically adds each layer
of the graphic as a separate track in the timeline.
This lets you apply effects and filters to individual
layers of the graphic, so you can give your movies
a unique appearance with stunning visual
animations.

New support for multi-layer graphics lets you apply effects and animations to the individual layers of an image.

Give it a try

Working with multi-layer graphics

1 Click the Edit step, and then drag any
.pspimage file to the Timeline.

2 In the PSP Layers dialog box, click Yes.

VideoStudio Pro X5 will distribute each layer of
the graphic to a separate track.

You can also press and hold the Shift key when
dragging an image file to the Timeline. This will
flaten the image, so you will lose the ability to

animate and edit individual layers.

3 Click on the image file in any track to edit that
layer.
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New! More multimedia tracks: You can now
add up to 20 overlay tracks to the main video
track in your project. Overlay tracks can include
video clips, photos, graphics, or titles. You can
also add an additional 2 title or subtitle tracks,
and up to 4 audio tracks. With access to 14 more
overlay tracks than previous versions, VideoStudio
Pro X5 gives you greater creative freedom to build
your movie precisely your way.

Give it a try

Using the Track Manager

1 In the Timeline, right-click and choose Track
Manager from the drop-menu.

Corel’
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Give it a try

2 In the Track Manager dialog box, specify the
number of tracks you want to add in each of
the following categories:

* Overlay Tracks
* Title Tracks
* Music Tracks

You can choose up to 20 overlay tracks, 2 title
tracks, and 3 music tracks.

3 To save your current settings for use in future
projects, click Set As Default.

4 Click OK.

New! Track visibility: For added convenience,
VideoStudio Pro X5 gives you the ability to show
or hide any of the tracks in the Timeline. With
plentiful track, overlay, and effects options, this
flexibility makes the composition process easier by
enabling your choice of which tracks to appear in
a particular output. For example, suppose you're
compositing a video that you want to output
with subtitles in multiple languages, you can now
easily show or hide the various subtitle tracks.

The eye of the track button indicates whether the
track is enabled or disabled. You simply click the
Track button to toggle its state. This track
visibility option is also useful for previewing the
effect of each track in your project without
having to repeatedly delete and import media.

New! Paste Optional Attributes command:
To accelerate the editing process, VideoStudio Pro
X5 now lets you choose which clip attributes you
want to paste. When you copy clip attributes, you
simply click Edit menu » Paste Optional
Attributes to open the dialog box, and then
enable or disable any attributes from the list. Your
choice of available attributes will vary based on
the type of media you have copied.

New! Canon DSLR support for Stop Motion:
VideoStudio Pro X5 augments its existing support
for HD video from Canon DSLRs by enabling these
cameras as a source for creating stop-motion
movies — a popular customer request. You
simply connect your Canon DSLR to your PC or
laptop with a USB cable. This new support also
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gives you additional creative options, such as
using your Canon DSLR to produce rich depth of
field and other effects.

New! 50p/60p support: This progressive-scan
frame rate is gaining traction in new HD
camcorders, offering exciting slow-motion
possibilities like those seen in sports television and
action movie montages. By adding support for
videos shot in 50p/60p, VideoStudio Pro X5 lets
you take full advantage of your camera’s
capabilities — a boon for videographers who
shoot action sequences.

New! 3D video import and editing:
VideoStudio Pro X5 now supports 3D webcam
capturing so you can easily import and edit 3D
video formats, such as Multiview Video Coding
(MVC) and Multiple Picture Object (MPO).
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Complete screencast production

The introduction of screen recording tools makes
VideoStudio Pro X5 a highly appealing option for
businesses, trainers, and educators. Conventional
screen recording software simply doesn’t offer the
high speed of compositing and editing, or the
variety of overlaying effects and rendering outputs
that VideoStudio Pro X5 makes possible.

Screen recording, or screencasting, is incredibly
useful — even for consumers. Consider the ease
of using a video to show a parent how to activate
their Skype account. Screen recording is also
gaining traction with game enthusiasts, who
enjoy capturing their gameplay and uploading it
to YouTube and other video sharing sites.

New! Screen recording: \With the new screen
recording tools, you can now use VideoStudio Pro
X5 to create polished screencasts — complete with
animations, effects, graphics, hyperlinks, music
tracks, titles, subtitles, and voice-over narration.

The Screen Capture tools help you record slide
shows, presentations, product demonstrations,
games, and instructional tutorials from a single,
easy-to-use interface. You can add descriptions,
informative graphics, or other decorations by
taking advantage of all the creative effects, menus,
transitions, titles, and animations that VideoStudio
Pro has to offer — and for approximately 1/3 the

cost of some other popular screencasting software.

The new Screen Capture tools let you record activity
on your computer screen.
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Give it a try

Ca pturing your screen

1 Click the Capture
the Screen Capture 2 icon.

step, and then click

2 In the Screen Capture dialog box, choose one
of the following options:
* Fullscreen — captures your entire screen
* Custom — lets you specify the screen area to
capture, or choose from a list of application
windows that are active on your computer

If you choose Custom, you can also type the
dimensions of the area you want to capture in
the W and H boxes.

Alternatively, you can use the Freehand

selection 4 tool and drag on the screen to
define the area you want to capture.

3 Click Start / Resume Recording a
You can press F11 to pause / resume recording.

You can press F10 to stop recording.

By default, screen captures are saved to the
Samples folder in the Library. You can drag a
screen capture into the Timeline for editing.

To choose a different location or to adjust file,
audio, and monitor settings, click Settings Esl.

New! Training distribution options:
Whether you're posting your video to YouTube,
outputting it for upload to another online sharing
site, rendering a video file for a specific device,
preparing a hosted video solution, or burning
discs, VideoStudio Pro X5 offers many
distribution options.

It's easy to produce professional training DVDs of
your screencasts, with custom disc menu
navigation. And with the new Burn from Disc
image (ISO) capability, you can quickly and easily
replicate discs. In addition, you can export directly
to YouTube, Facebook, Flickr, and HTMLS5 for web
sharing. Plus, you can output your screencast in a
wide variety of video file formats and resolutions,
including MPEG-2, MPEG-4, and WebM.
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Innovative sharing options

With VideoStudio Pro X5, you can easily share
your video online, output for specific mobile
devices, create professional-looking menus for
DVD and Blu-ray" discs, and burn from an ISO
disc image. In addition, new support for native
HTMLS5 authoring lets you build interactive
content for websites and online videos.

HTML

VideoStudio Pro X5 is the world’s first consumer video
editor to support native HTML5 output.

New! HTML5 authoring: VideoStudio Pro X5
now supports HTML5, the cutting-edge web
technology that's changing online video
distribution and consumption. You can now easily
create HTML5 output, complete with interactive,
hyperlinked on-screen cue and chapter points,
graphics, titles, as well as all the creative effects
that VideoStudio Pro has to offer.

With VideoStudio Pro X5, your HTMLS5 project is
output with both WebM and MPEG-4 (H.264)
web video objects to ensure that it will display in
browsers regardless of which web object format
the browser supports.

In addition, your HTML5 output can be opened
and edited in other HTML5 authoring
applications, such as Adobe® Edge, so it's easy to
share your project with others in a collaborative
effort.

You can use VideoStudio Pro X5 to create interactive HTML5 video output,
with navigable links and on-screen cues.

orel”
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New! HTMLS5 Instant Project templates:
You can get started with HTML5 immediately by
using an HTML5 Instant Project template. The
included templates are ideal for creating a
consistent look and feel for your webcasts, video
blogs, branded web video, and much more.

Give it a try

Using an HTMLS5 Instant Project template
1 Click File » New HTML5 Project.

2 In the Library, click the Instant Project
icon, and choose HTML5 from the template
categories.

3 Drag one of the available templates from the
Library into the Timeline.

4 You can now replace the placeholder images
with your own images and video clips, add Cue
and Chapter points just as you would in
building a DVD production, and create your
own custom text for titles and transitions.

Enhanced! Advanced disc authoring:
VideoStudio Pro X5 provides a robust disc
authoring solution that makes it easy to create
professional-looking DVD, AVCHD, Blu-ray, or
BD-J discs with menu navigation. You can now
export single clips from the disc authoring
interface, edit and create disc subtitles, add
custom disc menu icons, print disc labels, and
show or hide DVD subtitles. In addition, you can
use Multi-trim video to extract multiple clips, join
or separate videos, and undo any changes that
you’ve made in haste.

Plus, with the Batch Convert option, you can
quickly and easily convert a series of files in
sequence. You can convert files to any of the
supported video output formats, such as AVI,
3GPP2, 3GPP, MPEG-4, WebM, WMV, and many
more. After you have chosen an output format,
you can adjust the file settings for that particular
format, which is convenient if you are converting
files for viewing on a specific device.
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Give it a try

Batch converting multiple files
1 Click File » Batch Convert.

2 Click Add, navigate to the folder containing
the file(s) you want to convert, select the file,
and click Open.

Repeat this procedure to select additional files.

3 Click the Save as type drop-menu and choose
an output format from the list.

4 Click Options to adjust the General file
format settings and Compression method,
and then click OK.

For example, the General tab lets you choose
encoder driver, aspect ratio, frame rate settings,
and more.

5 Click Convert.

New! Burn from ISO: With VideoStudio Pro X5,
you can use the new Burn from disc image (ISO)
command to replicate your own DVD discs. You
can also create a disc image (ISO) for backup or to
burn to DVD in the future.

Give it a try
Burning from a disc image (ISO) file
1 Click Tools » Burn from Disc image (ISO).

2 In the Burn from Disc image dialog box,

click Browse [&@ to navigate to the folder that
contains the disc image you want to burn.

3 Click Copy
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Defining features

VideoStudio Pro X5 provides a straightforward way
to turn your video clips into full-fledged movie
productions. Its simple and intuitive workspace
guides you so you can quickly build your movie.

Here's a snapshot of features that are frequently
cited by users as the reason they chose
VideoStudio. This latest version also offers many
additional avenues of creative expression, including
templates, professional FX, as well as stop-motion
animation, chroma key, and time-lapse effects.

Easy 1-2-3 workspace: The clear-cut
VideoStudio Pro X5 workspace is suitable for
video editors of all skill levels and presents three
easy steps: 1-Capture, 2-Edit, and 3-Share.

The Capture step gives you easy ways to capture
or load media, the Edit step offers a wide variety
of video-editing options, and the Share step
presents all the output options you need to reach
your audience.

The Edit step of the VideoStudio Pro X5 workspace.

Corgl" . m
VideoStudio x5
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Timeline View and Storyboard View: The
Timeline lets you choose between two different
project views. Storyboard View offers the quickest
and easiest way to organize photos, graphics,
and video clips in a project. In Storyboard View,
project elements are presented in chronological
order as thumbnails. You can instantly rearrange
project elements by simply dragging the
thumbnails. The duration of each clip is shown at
the bottom of each thumbnail. In addition, you
can insert transitions between video clips, and

you can trim a selected video clip in the Preview
Window.

Simplicity makes the Storyboard View a great
option for new users, younger students, or those
stepping up from entry-level or free solutons,
such as Windows Movie Maker.

Timeline View gives you a more comprehensive
display of the elements in your movie project,
dividing a project into separate tracks for video,
overlay, title, voice, and music.

Storyboard View displays all media in your project as thumbnails in chronological order.

Chroma Key: You can apply a Chroma Key effect
to overlay clips, which lets you specify a color to
make transparent. For example, you can make the

background in an overlay clip transparent so that
it will absorb the colors of the Video Track.

The Chroma Key effect lets you superimpose a different background onto a video clip.

Easy online sharing: VideoStudio Pro X5
makes it fast and easy to share your video with an
online or mobile audience. The Share step
includes a convenient Upload to Web option,
which provides presets for uploading directly to
your Vimeo®, YouTube", Facebook®, or Flickr®
accounts.

[ 16 ] Reviewer's Guide

Export to Mobile Device: Available from the
Share step, this handy option makes it easy to
export your video files for viewing on mobile
devices. You can choose from a variety of device-
specific formats, frame rates, and frame sizes,
including iPods, iPhones, PlayStation Portables,
smart phones, and other mobile devices.

Corel
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Stop Motion animation: This classic
animation technique of giving life to inanimate
objects is fun for anyone interested in
filmmaking, and has produced renowned films
and television shows, such as Wallace & Gromit,
and Gumby.

For parents and kids, stop-motion is a fantastic
way to while away the hours on a rainy
afternoon. For teachers and students, it's a great
multifaceted learning opportunity. In addition to
endless amusement, you’ll exercise creativity,
story telling, orderly thought, project planning,

patience, and much more. And you can choose to
animate just about anything, like clay or putty,
building blocks, figurines, and other toys.

VideoStudio Pro X5 lets you capture images from
webcams, DV and HDV camcorders, and you can
also import images from supported Canon DSLR
cameras. When capturing images, you can choose
the exposure time for each image, adjust capture
resolution, or use Auto Capture to set automatic
time increments. In addition, the Onion Skin feature
lets you control the opacity of the new captured
image and the previous captured frame.

The Stop Motion tools offer endless fun and creative expression.

Give it a try

To create a manual stop-motion_
anlmatlon

1 With a webcam connected to your PC, click
the Capture step, and then click
Stop Motion

2 In the Stop Motion interface, type a name in
the Project Name box.

Corel”
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Give it a try

3 Choose the exposure time for each image from
the Image Duration drop-menu.

A higher frame rate results in a shorter
exposure time for each image.

4 Adjust the Onion Skin slider from left to right
to control the opacity of the new captured
image and the previous captured frame.

5 Click Save.
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Single Clip Trim: Trimming video is one of the
top motivators for consumers seeking video-editing
software. Many people are simply keen to upload a
piece of their video footage to Facebook or YouTube
for sharing. To that end, VideoStudio delivers quick
and easy ways to split and trim video with both
Single Clip Trim and Multi-trim Video options.

The Single Clip Trim dialog box makes it easy to
frame and accurately trim single clips. You can
access the dialog box by double-clicking any clip
in the Library.

You can quickly and easily trim video clips.

Give it a try

To trim a single clip

1 Double-click any clip in the Library.

2 In the Single Clip Trim dialog box, use the
Jog Wheel to select a starting point,
and click the Mark-in [l button (or press F2).

3 Select an endpoint, and click the Mark-out 1]
button (or press F3).

4 To preview the result, click Play
the Spacebar).

When you are satisfied with the result, click OK.

(or press

Multi-trim Video: With the Multi-trim feature,

you can easily extract multiple segments from any
video clip. The AccuCut timeline makes it fast and
simple to zoom in precisely on the exact frame

[ 18 ] Reviewer’'s Guide

that needs to be trimmed. You simply play the
video, click the Mark-in button to set the start
point for the trimmed clip, click the Mark-out
button to set the end point, and then repeat. The
trimmed clips appear in the Timeline, where you
can delete or re-adjust clips.

The Multi-trim Video dialog box includes a Jog
Wheel for quickly scrolling through video and a
Shuttle slider for easily finding exact frames. Plus,
the Ad-Zapper automatically detects commercials in
videos captured from TV, allowing for easy removal.

RotoSketch: The principles of rotoscoping —
tracing over live-action film movement to create
animation — are the foundation of RotoSketch.
By simply applying a GPU-optimized filter, videos
can be turned into realistic animated clips.

You can trace over live-action movement to
create realistic animated video clips.

Give it a try

To create a RotoSketch from a video clip

1 Click the Edit step, click the Media
icon in the Library Navigation panel, and then
drag a video clip to the Video Track in the
Timeline.

2 In the Library Navigation panel, click the Filter

icon, and then drag the RotoSketch filter
onto the clip in the Video Track.

3 In the Preview Window, click Play  to see the

sketch of the video clip.

Corel’
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Smart Proxy: While VideoStudio Pro X5
performs extremely fast on the latest multi-core
processors, it also users Smart Proxy to enable
owners of older PCs to work with HD video. By
using lower-resolution proxy files for editing and
previewing an HD project, VideoStudio Pro X5
requires fewer system resources, which results in
faster, smoother editing of HD video. The proxy
video is used only for editing. When it's exported,
the proxy clip links back to the original HD video,
so the final product is full HD quality.

Time-lapse / strobe effect: You can easily
create cool time-lapse or strobe effects from a
series of photos with VideoStudio Pro X5. Time-
lapse photography involves capturing a series of
consecutive photos of a gradually occurring
event, like moving traffic, a rising tide, or a
setting sun. For example, you might set a camera
to shoot an evening skyline every few seconds
over the course of 8 hours.

You can import the series of photos and specify
how many photos to keep, how many to discard,
and the duration of each frame in the resultant
clip. You can also use this effect on video clips.

You can create time-lapse or strobe
effects from a series of photos.

Corgl" . m
VideoStudio x5

Give it a try

To apply a time-lapse effect to photos

1 Click File » Insert Media File to Timeline »
Insert Photo for Time-lapse/Strobe.

2 Navigate to the folder containing the photos
for the project, select them, and click Open.
For best results, choose a series of photos taken
in succession from your DSLR.

3 In the Time-lapse/Strobe dialog box, press

Play to preview the clip created from
your series of photos.

4 |n the Keep box, specify the number of frames
to retain for your clip.

A frame is created for each photo in the series.

5 In the Drop box, specify the number of photos
that you do not want to include in the final
video clip.

This will create a rhythm for the time-lapse
effect. For example, you might keep one photo
and drop two, which will be repeated to
produce the time-lapse clip.

6 In the Frame duration box, specify the
exposure time for each frame.
If the Frame duration is more than 1 and
Total duration is shortened, you'll get a time-
lapse effect.

7 Press Play to preview the effect, and
click OK when you are satisfied with the result.
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FX Fade: With VideoStudio Pro X5, you can When an effect is eligible for fading, Fade buttons

easily fade-in or fade-out of certain effects. This is will be accessible from the Options panel.
useful, for example, if you want a picture-in- Alternatively, the right-click menu will present
picture window to appear or disappear gradually. Fade-in and Fade-out options for eligible effects.

With some effects, you can fade-in or fade-out to create a stylish transition.

- . Painting Creator: \With the Painting Creator,
Give it a try you can record painted, drawn, or written strokes
To apply FX Fade on a clip as an animation to use as an overlay effect. For

example, you can enhance a family vacation video
by drawing your route on a map and overlaying it
on the video. The Painting Creator lets you choose
2 Right-click the clip, choose Copy from the to create still paintings or animations.

drop-menu, and then click to position the clip
at the 2 second mark in the Overlay Track.

1 Drag a video clip to the Video Track in the
Timeline.

3 Position your cursor toward the end of the
overlay clip and drag to shorten the clip by 2
seconds.

4 In the Library Navigation panel, click the FX
icon, and drag AutoSketch to the clip in the
Overlay Track.

5 Click the Options button, click the
Attributes tab, click the Fade In  button,
and then click the Fade Out  button.
Note: You can also apply FX Fade by clicking
Customize Filter |, and then setting the

fade-in and fade-out points in the dialog box. The Painting Creator lets you add personalized overlay

6 Drag the Scrubber  to the start of the video effects, such as a particular route over a map.

and press Play  to see the result.

Corel’
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Multi-threading: stunning HD performance via multi-core acceleration

When run on a modern multi-core processor,
VideoStudio Pro X5 is the fastest version of
VideoStudio yet. It is also the clear leader in
video-editing performance when tested against
competitors in its cateory.

In a test environment running a 2nd Generation
Intel® Core™ i7 2600 processor @ 3.4 GHz with

8GB of RAM and Intel Sandy Bridge HD Graphics,

we tested VideoStudio Pro X5 against both
VideoStudio Pro X4 and our leading competitors
in the consumer video-editing space.

Video preview performance scenario

Video preview is the act of watching video within
the preview window.

Stalls, crashes, lag, or dropped frames will result
when the software is overburdened.

The table below outlines what happened when
we tried playing 10 HD video streams:

VideoStudio | VideoStudio Competltor Competltor Competltor Competltor
Pro X5 Pro X4

Dropped 4625 Lag and some Serious lag, Playback lag Serious lag;
Frames (V|rtuaIIy dropped poor video after 10 sometimes app
real time) frames playback seconds, some  will auto-stop
quality frames video playback
29.82 2.97 dropped at beginning
second (FPS)
CPU% 68.32 24.57 21.24 61.20 82.71

(average
resource

load)

Result: While test limitations meant we could
not measure frame rates for all competitors,

VideoStudio Pro X5 is visibly the better performer

on HD preview than all competitors, delivering
real-time playback while other competitors
present lag issues and drop many frames.

Corel”

VldeoStudlo X5

Version to version, VideoStudio Pro X5 runs close
to 10 times faster than VideoStudio Pro X4.
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Transcode performance scenario

Hardware acceleration refers to the software’s
ability to leverage a processor’s specific abilities to
speed up certain aspects of the video-editing
process.

High-powered processors from Intel and AMD
have been designed to accelerate certain
computing tasks. Software developers can
generate dramatic speed gains for the user by
taking efficient advantage of the hardware’s
potential.

Result: VideoStudio Pro X5 rendered the 10-
minute clip in 146 seconds (2 mins, 26 seconds)
compared to 251 seconds (4 mins, 11 seconds)
for Competitor A.

In this test scenario, VideoStudio Pro X5 is 72%
faster than Competitor A.

Benchmarking notes: By our measures,
VideoStudio Pro X5 offers the fastest and most
responsive video-editing performance available.

The truest measure, however, is real-world
performance. We challenge video enthusiasts to
download VideoStudio Pro X5 and test our
performance for themselves.
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Both VideoStudio Pro X4 and VideoStudio Pro X5
use hardware acceleration to boost the speed and
performance of the editing process; however,
only one other competitor effectively uses
hardware acceleration. This substantially narrows
the field of potential video-editing software for
performance-oriented users.

The following chart illustrates the result of this
rendering test scenario, which transcoded a
10-minute HD video file from MPEG-2 to AVCHD
format (specifically MPEG-2 19201080 to
AVCHD 1440x1080):

VideoStudio® Pro comparisons

VideoStudio Pro X5 uses multi-threading to take
maximum advantage of the processing power of
multi-core technology. With VideoStudio Pro X4,
we had used multi-core processing to accelerate
certain parts of a production.

For example, effects overlaid on an HD stream
could now occur in real time. With multi-
threading, we've enabled greater depths of
optimization by simultaneously accessing each
processor core, which lets VideoStudio Pro X5
perform faster in every way.

Corel’
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Video overlay scenario 1: Applying a picture- With a simple picture-in-picture scenario in

in-picture effect in an HD video, or overlaying VideoStudio Pro X4, you could drive 2 HD streams
complex motion graphics, places a heavy over one another without lag or noticable impact
processing load on your PC. on the video preview (in this case, we used

AVCHD lite MTS video @ 1080p taken from a
Panasonic TSC-1 ruggedized point and shoot).

Scenario 1. VideoStudio Pro X4 running 2 simultaneous HD streams (top) and
VideoStudio Pro X5 running 5 simultaneous HD streams (bottom).

Result: In VideoStudio Pro X5, video in the same multi-core acceleration when laying on other
format can be layered on consistently with 5 HD processor-intensive tasks, such as animated
streams without lag or noticeable impact on the picture-in-picture windows with effects, motion
video preview. While few users will layer on that graphics, or 3D titles from software like

many streams at once, they will benefit from MotionStudio 3D.

Corel [Pro} . .
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Video overlay scenario 2: VideoStudio Pro X4 VideoStudio Pro X5 takes advantage of every

used multi-core processing optimizations to available core simultaneously, which results in
distribute specific intensive rendering tasks to maximum performance at all times. In the
different cores. following screen captures from a Lenovo W520

laptop equipped with an Intel Core i7 2720m @
2.8GHz, note the engagement level of each core.

Scenario 2: VideoStudio Pro X4 calls on cores as they are needed to accelerate effects or specific use cases (top),
and VideoStudio Pro X5 engages every core, tapping the full power of Intel’s powerful Core i7 processor (bottom).

Corel’
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Video overlay scenario 3: In different use means that, on advanced processors like an Intel
cases, further performance gains are possible. Core i7 there is no faster consumer video editor
This level of multi-core performance ranks X5 as — period.

the fastest ever version of VideoStudio, but it also

Scenario 3: VideoStudio Pro X5 playing 8 HD video clips @ 1080p simultaneously.

Corel®
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About Corel

Corel is one of the world’s top software companies, with more than 100 million active users in over 75
countries. We develop software that helps people express their ideas and share their stories in more
exciting, creative, and persuasive ways. Through the years, we've built a reputation for delivering
innovative, trusted products that are easy to learn and use, helping people achieve new levels of
productivity. The industry has responded with hundreds of awards for software innovation, design, and
value.

Our award-winning product portfolio includes some of the world’s most widely recognized and popular
software brands, including CoreIDRAW® Graphics Suite, Corel® Painter”, Corel DESIGNER® Technical
Suite, Corel® PaintShop™ Pro, Corel® VideoStudio®, Corel® WinDVD®, Corel® WordPerfect® Office, and
WinZip®. Our global headquarters are in Ottawa, Canada, and major offices are in the United States, the
United Kingdom, Germany, China, Taiwan, and Japan.
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